KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1

Code No. Subject Marks Time
BFAD-101 | History of Indian Clothing 120+30* 3 hrs.
BFAD-102 | Basic Sewing Techniques 120+30* 3 hrs.
BFAD-103 | Introduction to Computer-| 120+30* 3 hrs.
BFAD-104 | English 120+30* 3 hrs.
BFAD-105 | Environment Studies (80+20%)* 3 hrs.
Practical / Lab based Courses

BFAD-151 | Basic Sewing Techniques 50 3 hrs.
BFAD-152 | Pattern Making -l 50 3 hrs.
BFAD-153 | Computer Lab-I 50 3 hrs.

TOTAL 850

Internal Assesment
# Project Work
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BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1
HISTORY OF INDIAN CLOTHING
(THEORY)
Course Code: BFAD-101 Duration of exam: 3 hrs

M.M.: 150
Theory Exam: 120
Int. Assesment: 30

» Examiner will set nine questions in all
* All the questions will carry equal marks
* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
* The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
« The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.
Unit-1
PART-I
Origin of Clothing:-
» Evolution of Dress
» Symbolical significance
» Art of weaving
» Functions of clothing

PART-I

Ancient Indian costumes:-
* Indus valley civilization

* Vedic age

* Middle ages

« Mauryan’s influence

» Satahanavanas

« Kushan’s

» Gupta period

e Muslim Period
 Infiltration of western influence.

PART-II

 Traditional costumes of different regions of India

REFERENCES




Text books:
e Flynn, D. 1971. Costumes of India, New Delhi, Oxford and IBH Publishing
Company
« Roshen Alkazi. Ancient Indian Costume
« P. Rambanch and V Golich. The Gloden Age of Indian Art
 J.Brij Bhusha. The Costumes and Textiles of Indian

Magazines/Journals:
» Apparel online.com
* Apparel View

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
BASIC SEWING TECHNIQUES
(THEORY)

Course Code: BFAD-102 Duration of exam: 3 hrs
M.M.: 150
Theory Exam: 120
Int. Assesment: 30
e Examiner will set nine questions in all
* All the questions will carry equal marks
* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
» The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
e The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit-|
. Introduction to sewing — history of sewing machine.
. Sewing machines — different types of sewing machines and their maintenance,
common problems and their remedies, tools and equipments.
. Introduction to manufacture of sewing threads and their properties.
. Sewing techniques — Basic hand stitches — Basting, running, tacking, hand over-
cast, hemming stitches- plain and blind, slip stitch, tailor's tack.
. Seams and seam finishes — definition, types of seams finishes and their
applications.
. Fullness — darts, tucks, pleats, gathers — definition, terms, types and application
. Yokes--definition, purpose, with and without fullness, applications and
construction.



. Sleeves — definition, terms and types

. Collars — definition, terms, types and styles.
. Different types of pockets.

. Different types of skirts.

. Fastners — definition, types, present trends.
. Finishes — neckline finishes — binding, facing.
. Plackets — definition, types of placket finishes.
. Different types of trimmings.
Unit-ll
. Terminology — notches, grain, grain line, construction lines, center-front line , bias,

true bias, bust line, waistline, seam line, seam, seam allowance, jog seams, dart points,
direction of dart excess.

. Figure analysis-body ideals, body proportion, and height and weight distribution,
individual figure analysis.

. Anthropometric Measurements — Study of all body measurements for all age
groups — infants, children, women and men; standards of body measurement,
importance, standardization and size charts.

. Methods of garment construction — drafting, draping and flat pattern, principles,
advantages and disadvantages.

REFERENCES

Text books:
* Thomas Anna Jacob: “The Art of Sewing”. New Delhi, USB Publisher Distributors
Ltd. 1994.
» Reader’s Digest “Complete Guide to Sewing”, Reader Digest 1995.
* Verma G. “Cutting Theory”. Asian Publishers, Delhi. 1999.
» Sheri Doongaji. Basic Principles of Construction.
* Mc Calls’s. Mc Calls’s Sewing Book.
» Singer Sewing Essentials, Cowels Creative Publishing, Inc. 1996.
» Sewing Basics, Wendy Gardiner, Saly Milner publishing. 2003.




KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1
INTRODUCTION TO COMPUTER-I
(THEORY)
Course Code: BFAD-103 Duration of exam: 3 hrs

M.M.: 150
Theory Exam: 120
Int. Assesment: 30

» Examiner will set nine questions in all
* All the questions will carry equal marks
* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
* The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
« The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.
Unit-1
Computer Fundamentals and DOS
e Introduction to computer
» Application of computer in the fashion/ textile/ graphic design etc.
» Difference between hardware and software
* Renaming file
* Activities file
* Booting
* Type of memory
* Understanding the term “Byte”
Introduction to DOS
» Difference between a ‘File and a ‘Directory’
 DOS commands: MD,CD,RD
« Copy con: DIR, COPY, REN, DEL, CLS
« Date, time, deltree, format, attrib
Unit-Il

Windows Operating System
* Introduction to Windows
o Study of MS-Office
*  MS-Word — detailed study
* MS-Power Point — detailed study
« MS-Excel — basic knowledge
* Windows explorer
» Paintbrush
* Notepad



Difference between single tasking and multi tasking operating systems
Advantages of windows over DOS

Manipulating a windows opening, closing, moving, maximizing and minimizing a
window

Accessories Group: Clock, Calendar, Notepad and Calculator

REFERENCES

Text book:

Microsoft Office 2000 Complete, BPB Publications.
Sinha, Computer Fundamentals, BPB Publications, 2003

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
ENGLISH
(THEORY)

Course Code: BFAD-104 Duration of exam: 3 hrs

M.M.: 150

Theory Exam: 120

Int. Assesment: 30
Examiner will set nine questions in all
All the questions will carry equal marks
Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit-|

Communicative Grammar:

Part A: Spotting the errors pertaining to nouns, pronouns, adjective and adverbs;
Concord - grammatical concord, notional concord and the principle of proximity
between subject and verb.

Part B: Changing the voice: from Active to Passive and Passive to Active.

Lexis: Idioms and phrases; Words often confused; One-Word Substitutes;
Formation of words (suffixes, prefixes and derivatives);

Oral Communication:



Part-A: Introduction to principal components of spoken English — Transcription,
Word accent, Intonation, Weak forms in English
Part-B: Developing listening and speaking skills through various activities, such
as (a) role play activities, (b) Practising short dialogues (c) Group discussion (d)
Debates (e) Speeches (f) Listening to news bulletins (g) Viewing and reviewing
T.V. programmes etc.

Unit-ll

Written Communication: Developing reading and writing skills through such
tasks/activities as developing outlines, key expressions, situations, slogan writing
and theme building exercises, dialogue writing, interpreting pictures/cartoons.
(For Internal Evaluation Only):

Book Review — Herein the students will be required to read and submit a review
of a book (Literary or non-literary) of their own choice. This will be followed by a
presentation of the same in the class.

Technical Writing:

(a) Business Letters, Format of Business letters and Business letter writing

(b) E-mail writing

(c) Reports, Types of Reports and Format of Formal Reports

(d) Press Report Writing

REFERENCES

Language in Use (Upper intermediate Level, Adrian Doff Christopher Jones,
Cambridge  University Press

Common Errors in English, Abul Hashem, Ramesh Publishing House, New Delhi.
Objective English, Tata Mc. Graw Hill Publishing Company Ltd., New Delhi.
Spoken English for India, R.K. Bansal & J.B. Harrison, Orient Longman, Delhi.
The sounds of English, Veena Kumar, Makaav Educational Software, New Delhi.
English Phonetics & Phonology, P. Roach, Cambridge University Press, London.
English for Engineers and Technologists: A Skill Approach, Vol. 2, Orient
Longman, Delhi.

Business Communication, M.S. Ramesh and C.C. Pattanshetti, R.Chand and
Company, Delhi

Group Discussion, Sudha Publications/Ramesh Publishing House, New Delhi.
English Grammar & Composition. By Rajinder Pal & Prem Lata Suri, Sultan
Chand Pub. New Delhi.

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
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ENVIRONMENT STUDIES
(THEORY)

Course Code: BFAD-105 Duration of exam: 3 hrs

M.M.: 100
Theory Exam: 80
Int. Assesment: 20

» Examiner will set nine questions in all

* All the questions will carry equal marks

* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus

* The remaining eight questions will be set from unit 1 and 2, four questions from
each unit

« The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit-l

The Multidisciplinary nature of environmental studies
» Definition, scope and importance.
* Need for public awareness.

Natural Resources
Renewable and non-renewable resources:
* Natural resources and associated problems.

a.

f.

Forest resources: Use and over-exploitation, deforestation, case
studies. Timber extraction, mining, dams and their effects on forests and
tribal people.

Water resources: Use and over-utilization of surface and ground water,
floods, drought, conflicts over water, dams-benefits and problems.

Mineral resources: Use and exploitation, environmental effects of
extracting and mineral resources, case studies.

Food resources: World food problems, changes caused by agriculture
and overgrazing, effects of modern agriculture, fertilizer-pesticide
problems, water logging, salinity, case studies.

Energy resources: Growing energy needs, renewable and non-
renewable energy sources, use of alternate energy sources. Case
studies.

Land resources: Land as a resource, land degradation, man induced
landslides, soil erosion and desertification.

* Role of an individual in conservation of natural resources.
» Equitable use of resources for sustainable lifestyles.
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Ecosystems

Concept of an ecosystem.

Structure and function of an ecosystem.

Producers, consumers and decomposers.

Energy flow in the ecosystem.

Ecological succession.

Food chains, food webs and ecological pyramids.

Introduction, types, characteristic features, structure and function of the
following ecosystem :

o Forest ecosystem

o Grassland ecosystem

o Desert ecosystem

o Agquatic ecosystems (ponds, streams, lakes, rivers, oceans, estuaries).

Biodiversity and its conservation

Introduction — Definition: genetic, species and ecosystem diversity.
Biogeographical classification of India.

Value of biodiversity: consumptive use, productive use, social, ethical,
aesthetic and option values.

Biodiversity at global, National and local levels.

India as a mega-diversity nation.

Hot-spots of biodiversity.

Threats to biodiversity: habitat loss, poaching of wildlife, man-wildlife conflicts.
Endangered and endemic species of India.

Conservation of biodiversity: in-situ and ex-situ conservation of biodiversity.

Unit-ll

Environmental Pollution
Definition

Causes, effects and control measures of :

Air pollution

Water pollution

Soil pollution

Marine pollution

Noise pollution

Thermal pollution

o Nuclear hazards

Solid waste management: Causes, effects and control measures of urban and
industrial wastes.

Role of an individual in prevention of pollution.

Pollution case studies.

Disaster management: floods, earthquake, cyclone and landslides.

0O O O O O O

Social Issues and the Environment



e From unsustainable to sustainable development

e Urban problems related to energy

» Water conservation, rain water harvesting, watershed management

« Resettlement and rehabilitation of people; its problems and concerns. Case
studies.

« Environmental ethics: Issues and possible solutions.

» Climate change, global warming, acid rain, ozone layer depletion, nuclear
accidents and holocaust. Case studies.

* Wasteland reclamation.

» Consumerism and waste products.

* Environment Protection Act.

» Air (Prevention and Control of Pollution) Act.

* Water (Prevention and Control of Pollution) Act

» Wildlife Protection Act

* Forest Conservation Act

* Issues involved in enforcement of environmental legislation

e Public awareness.

Human Population and the Environment
e Population growth, variation among nations
» Population explosion — Family Welfare Programme
e Environment and human health.
* Human Rights.
* Value Education.
» HIV/AIDS
*  Women and Child Welfare.
* Role of Information Technology in Environment and human health.
» Case Studies.
Field Work
* Visit to a local area to document environmental assets-river / forest /
grassland / hill / mountain.
» Visit to a local polluted site — Urban / Rural / Industrial / Agricultural.
» Study of common plants, insects, birds.
» Study of simple ecosystems — pond, river, hill slopes, etc.

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
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BASIC SEWING TECHNIQUES

(PRACTICAL)
Course Code: BFAD-151 Duration of exam: 3 hrs
M.M.: 50
Practical Exam: 50
Making samples of:-
. Basic hand stitches- basting, running, hemming, overcasting, herringbone, back
stitch etc.
. Seams and seam finishes — plain, flat, run and fell, French, montuamaker's seam,
counter hem' over lock, hand over cast, turned and stitched, binding.
. Fullness - darts, tucks, pleats, gathers, ruffles , frills
. Yokes - yoke with and without fullness
. Drafting & Construction of Collars— Stand and fall, peter-pan, shawl, sailor's,
mandarin, cape.
. Pockets — Patch, welt, in-seam, bound, flap pocket, kurta pocket.
. Fasteners.
. Neckline Finishes- Facing, Binding.
. Plackets — Continuous, two piece placket, extended bodice.
REFERENCES
Text books:

Armstrong, J.H. “Pattern making for fashion design” Pearson Education. 2001.
Readers Digest sewing book.

Thomas Anna Jacob. "The art of sewing", USB publishers New Delhi, 1994.
Verma, G. Cutting & Tailoring Theory", Asian publishers Delhi, 1999.

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
PATTERN MAKING-I (PRACTICAL)
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Course Code: BFAD-152 Duration of exam: 3 hrs

M.M.: 50
Practical Exam: 50

The Workroom:- Pattern making tools, Industrial dress form, Pattern paper
1. Completing the pattern, pattern grain lines, and balance line terms.
Figure analysis: - Standard ideal figure, Pattern industry standards,
Individual figure analysis.
Measuring techniques:-
1. Introduction ,Measurement charts, Tools for measuring process, Land mark
terms
2. Standard body measurements: - Child, Adult, Men and Women.
3. Girth measurements, measuring the forms: - HBL, horizontal and vertical
measurement, strap measurement.
Making Basic Body Slopers of children and adult :-
1. Bodice - Front / back.
2. Skirt - Front / back.
3. Sleeve
Making paper pattern of :-
1. Darts, notches, pleats.
2. Gathers and tucks.
3. Sleeves — Plain, puff, raglan, kimono, leg-o-mutton, bishop and bell sleeve.
Fitting the bodice, necklines, armhole and sleeve.
Pattern making techniques :-
1. Design analysis and 3 maijor principles.
2. Pattern making terms.
3. Test- Fit

REFERENCES

Text books:

Aldrich Winifred. Metric Pattern Cutting. Om Book Service. 1997.
Armstrong H.J. Pattern Making for Fashion Design. Longman. 2003.

12



- Bray Natalia. More Dress Pattern Designing. Blackwell Science. 1999.

e Cooklin Gery. Pattern Cutting for Women’s outer Wear. Blackwell Science. 2001.

« Cooklin Gery. Garment Technology for Fashion Designers. Blackwell Science.
1997.

« Kapoor Bela. Pattern Drafting and Making. Phoenix Publishing House Pvt.Ltd.
1999.

Magazines/Journals:
e Apparel online.com
e Apparel views

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1
COMPUTER LAB-|
(PRACTICAL)

Course Code: BFAD-153 Duration of exam: 3 hrs
M.M.: 50
Practical Exam: 50

 How to operate windows

* Word processing software, preparation, saving and printing of text documents.
*  Microsoft Office Word

*  Microsoft Office Excel

*  Microsoft Office PowerPoint

e Paint

REFERENCES:

Text books:
. Winfred Aldrich. CAD in Clothing and Textiles, Blackwell Science, 1994.
. Annual World, Computer in the World of Textiles Institute, UK.

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1I
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Code No. Subject Marks Time

BFAD-121 Textile Science 120+30* 3 hrs.

BFAD-122 Traditional Indian 120+30* 3 hrs.
Embroideries & Textiles

BFAD-123 Elements & Principles of 120+30* 3 hrs.
Design

BFAD-124 Garment Construction 120+30* 3 hrs.

Practical / Lab based Courses

BFAD-171 Textile Testing 50 3 hrs.

BFAD-172 | Computer Lab 50 3 hrs.

BFAD-173 | Children’s Clothing 50 3 hrs.

BFAD- 174 | Elements & Principles of 50 3 hrs.

Design
TOTAL 800

*

Internal Assessment

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1I
TEXTILE SCIENCE
(THHEORY)
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Course Code: BFAD-121 Duration of exam: 3 hrs

M.M.: 150
Theory Exam: 120
Int. Assesment: 30

« Examiner will set nine questions in all

« All the questions will carry equal marks

* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus

* The remaining eight questions will be set from unit 1 and 2, four questions from
each unit

e The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit — |
Introduction to textile fibers, classification of fibers based on sources and origin,
basic textile terminology.
Primary and secondary properties of various fibers.

Sequence of operations & purposes of short/long staple yarn manufacturing
process, introduction & objectives of opening & cleaning, carding, combing, drawing,
roving and spinning.

Different methods and types of spinning.
Introduction, Manufacturing & Properties of different natural and man-made fibers:-
Cotton, Wool, silk, rayon, acetate and triacetate, polyamide (Nylon-6, nylon- 6.6)
acrylics, modacrylic, elastomeric fibre.

Unit — 1l
Classification of Yarns: Carded and Combed yarns, woolen & worsted yarns,
filament and spun yarns.
Yarn Properties — linear density, size, twist in yarn, crimp twist direction, strength
and uniformity.
Textured yarns — types and application, Fancy Yarns — types and uses.
Physical properties of Fabric — strength, abrasion resistance, crease recovery,
stiffness, drapability, static charge, thermal conductivity, air permeability, water
repellency, thickness, shrink resistance, pilling resistance.
Methods of determining the physical properties and interpretation of test results.

Note: Use simple methods only.

Fiber identification — visual, burning, microscopic and solubility test.
Fibre blends analysis.

Measurement and interpretation of yarn count, direct and indirect yarn.
Identification of type of yarn.

15



» Evaluation of thread count and dimensional stability of fabric.
» Evaluation of color fastness to washing and ironing.
» Evaluation of crimp and twist in yarn.

REFERENCES

Text books:

« Vilensky. "Textile Science", CBS publisher, New Delhi, 1999.

Grosicki, Z. "Watson's Textile Design and Color" Blackwell Science, U.K., 1998.
Mishra, S.P. "A text book of fiber science and technology, New Age Intt., Delhi 2000.
Goswami, B.C. "Textile Yarns", Technology, structure and applications", Mc graw
Hill.

» Pizzoto's J.J. "Fabric Science", Fairchild Publication, New York.
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KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1I
TRADITIONAL INDIAN EMBROIDERIES AND TEXTILES
(THEORY)
Course Code: BFAD-122 Duration of exam: 3 hrs

M.M.: 150

Theory Exam: 120

Int. Assesment: 30
Examiner will set nine questions in all
All the questions will carry equal marks
Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit-l

Traditional and commercial embroideries of different region of India:- Kutch,
Kathiawar, Phulkari, Sindhi, Kantha, Kausuti, Chamba rumal, Kashida, Manipuri,
Chikankari and Zardozi with their commercial importance.

Unit-ll
Traditional woven textiles of India: Dacca muslin and Jamdani, Baluchari,
Pochampalli, Patola and |kat, Kanchipuram sarees, Chanderi sarees, Maheswari
sarees, Vichitrapuri sarees and Brocades, Woven shawls of Kashmir, Himachal
Pradesh and North Eastern States.
Printed and Painted textiles:- Block printed textiles, Tie and dyed textiles,
Kalamkari and Madhubani.

REFERENCES

Pandit, S. 1976. Indian Embroidery: Its Variegated Charms. Baroda.

Mehta, R.J. 1970. Masterpieces of Indian Textiles. Bombay, D.B. Taraparevala
Sons and Co. Pvt. Ltd.

Gillow. Indian Textiles.

Lehri, R.M. Indian Embroideries.

Ghosh. Ikat Textiles of India

Shailza, D. Naik. Traditional Embroideries of India
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KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1I
ELEMENTS & PRINCIPLES OF DESIGN
(THEORY)
Course Code: BFAD-123 Duration of exam: 3 hrs

M.M.: 150

Theory Exam: 120

Int. Assesment: 30
Examiner will set nine questions in all
All the questions will carry equal marks
Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus
The remaining eight questions will be set from unit 1 and 2, four questions from
each unit
The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit-1
Elements of Design: - Line, shape, texture, color, pattern.
Line Art: - Diagonal, horizontal, vertical, stripes & checks.
Principles of Design: - Harmony, Rhythm, Balance, Proportion, Emphasis

Unit-lI
Colour: Light and colour phenomenon, colour theories as light pigment or
Brewster Colour theory, psychological effect of colour, classification of colour.
Colour Wheel: - Tints and shades, value, hue, intensity, saturation.
Colour schemes and application of colour combination in designing of clothing or
fabric.

REFERENCES

Text books:

David Hormg. Colour—A workshop for Artists and Designers. Laurence King
Publishing. 2005.

Hideaki Chijiwa. Color Harmony. Rockport Publishers.1992.

Mary Ganthe. Fashion and Color. Rockport Publishers. 1992.

Sawahata Lesa. Color Harmony Workbook. Rockport Publishers. 2001.

Sumathi, G.J. Elements of Fashion and Apparel Design. New Age International
Publishers. 2002.

Tatham Caroline and Seaman Julian. Fashion Design Drawing Course, Thames
and Hudson. 2003.

Magazines/Journals:

Apparel online.com
18



e Apparel views

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1I
GARMENT CONSTRUCTION
(THEORY)

Course Code: BFAD-124 Duration of exam: 3 hrs
M.M.: 150
Theory Exam: 120
Int. Assesment: 30

e Examiner will set nine questions in all

* All the questions will carry equal marks

* Question No. 1 will be compulsory consisting of 5-10 short type questions and
spread over the entire syllabus

» The remaining eight questions will be set from unit 1 and 2, four questions from
each unit

e The candidates are required to attempt five questions. Q.No. 1 will be
compulsory and remaining four questions will be attempted selecting two
questions from each unit.

Unit — |

» Fabric Preparation.

* Handling special fabrics.

» Suitability of different fabrics for different garments.

» Principles of fitting, factors to be considered while fitting, common fitting
problems, remedying fitting defects.

Unit — 1l
« Terminology related to skirts, trousers, collars, sleeves.
» Lining, interlining, facing & interfacing.
» Clothing for different age groups.
» Clothing for different occasions.
* Fabric estimation and its importance.

REFERENCES

Text books:

19



Carp and Latham. The Technology of Clothing Manufacture.

Greff and Strom. Concepts of Clothing.

Thomas Anna Jacob: “The Art of Sewing”. New Delhi, USB Publisher Distributors
Ltd.1994.

Reader’s Digest “Complete Guide to Sewing”.1995.

Cooklin Grey. Garment Technology for Fashion Designer, Blackwell Science.
1997.

20



KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1I
TEXTILE TESTING
(PRACTICAL)

Course Code: BFAD-171 Duration of exam: 3 hrs
M.M.: 50
Practical Exam: 50

Note: Use simple methods only.
» Fiber identification — visual, burning, microscopic and solubility test.
* Yarntests:-
1. Ply and filaments
2. Yarn count
3. Crimp
4. Twist
5. Tenacity and elongation
« Fabric dimensions :-
1. Width
2. Fabric Count
3. Thickness
4. Weight
« Fabric wearing qualities :-
Abrasion
Stiffness
Drape
Breaking strength and elongation
Bursting and tearing strength
. Shrinkage
* Colour Fastness to :-
1. Sun light
2. Laundering
3. Crocking/rubbing
4. Perspiration

oo s N~

REFERENCES

Text books:

* Angappan, P. and Gopalakrishnan, R. 2002. Textile Testing. Eroad, Tamilnadu,

S.S.M. Institute of Textile Technology.

+ Booth, J. E. 1974. Principles of Textile Testing. I*ed. New Delhi, CBS Publishers &

Distributors.
» ISl Handbook of Textile Testing. 1982. New Delhi, Indian Standards Institution.
» Vilensky, "Textile Science", CBS publisher, New Delhi, 1999.
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« Mishra S.P. "A text book of fiber science and technology, New Age Intt., Delhi
2000.
» Pizzoto's J.J. "Fabric Science", Fairchild Publication, New York.

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1I
COMPUTER LAB
(PRACTICAL)

Course Code: BFAD-172 Duration of exam: 3 hrs
M.M.: 50
Practical Exam: 50

Experiment-|
Introduction to Photoshop
» Interface
» Tool box and Palettes
* Layers, File types and Resolution
Experiment-I|
Enhancing Image
» Color Balance, Cropping and Cloning Stamp
* Brightness, Hue, Blur, Burn etc
Experiment-lll
Blending Images
» Selection Tools
* Transform
Experiment-IV
Special Effect
» Filter
» Layer Style
* Opacity
Experiment-V

Drawing Tools

22



» Color Selection, Gradients
* Type Tool, Paint Tools
» Vector shapes
* Importing graphics files from Corel Draw
Experiment-VI
Introduction to Corel Draw
» Difference Between Corel and Paintbrush
» Difference between vector and bitmap image
* Overview of Corel Draw
Experiment-Vli
Working with Corel Draw
* Opening a new graphics
* Modifying existing graphics
» Saving a file
Experiment-IX
Introduction to drawing tools
» Use of freehand and Bezier tools
» Use of square, polygon tools
» Use of pencil tool to draw straight lines
* Understanding about open and closed shapes
Experiment-X
Changing attributes of graphical objects i.e. fill and outline color and style
* File menu
»  Working with text
» Creating special effects
» Working with objects
* Create symbols and patterns
» Shortcut keys
» Assignments-working on designing care labels, tags, logos, letterheads, visiting

cards etc
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Experiment-XI

Page Maker
REFERENCES

Rebecca Bridges Altman, Rich Ailman, Mastering page maker 6 for Windows 95
Rick Altman, Corel Draw 9

KURUKSHETRA UNIVERSITY KURUKSHETRA
BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)
SEMESTER-1I
CHILDREN’S CLOTHING
(PRACTICAL)

Course Code: BFAD-173 Duration of exam: 3 hrs

M.M.: 50
Practical Exam: 50

Drafting and construction of Layette set :-
1. Bib, Diaper, Panty, Bloomer, Jhabla.
Making samples of :-
1. Skirt and its variations.
Construction of :-
1. Dress for casual wear.
2. Dress for formal wear.
3. Dress for night wear.

REFERENCES

Thomas Anna Jacob, "The art of sewing". New Delhi, USB Publishers. 1994.
Readers Digest sewing book.

Verma, G. Cutting & Tailoring Theory", Delhi, Asian Publishers. 1999.

Cooklin, G. Garment Technology for Fashion Designers” Blackwell Publishing.
1977.

KURUKSHETRA UNIVERSITY KURUKSHETRA
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BACHELOR OF FASHION AND APPAREL DESIGN (BFAD)

SEMESTER-1I
ELEMENTS & PRINCIPLES OF DESIGN
(PRACTICAL)
Course Code: BFAD-174 Duration of exam: 3 hrs

M.M.: 50
Practical Exam: 50

» Study about the different art materials and their uses.

* Lines — effect of lines, optical illusion with lines, regular & irregular lines.

» Shapes - classification, types, composition of different shapes.

« Forms - silhouettes and its types.

» Colour- colour wheel, tints and shades, colour schemes.

« Texture- formation of texture by different methods:- impression method, thread
rolling, spray method.

» Principles of design and their applications.

« Formation of any three designs by using elements and principles of design.

« Enlargement and reduction of design motifs.

« Patterns — geometrical, floral, abstract, nursery prints etc.

REFERENCES
Text books:
« David Hormg. Colour—A workshop for Artists and Designers, Laurence king
publishing, 2005.
Hideaki Chijiwa. Color Harmony, Rockport Publishers. 1992.
Mary Ganthe. Fashion and color, Rockport Publishers. 1992.
Sawahata Lesa. Color Harmony Workbook, Rockport Publishers. 2001.
Sumathi G.J. Elements of fashion and Apparel Design, New Age International
Publishers. 2002.
« Tatham Caroline and Seaman Julian. Fashion Design Drawing Course, Thames
and Hudson. 2003.

Magazines/Journals:

* Apparel online.com
* Apparel views
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